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Introducing the N8221A IF Digitizer

The Agilent Technologies N8221A IF digitizer with 7.5 MHz IF input provides 80 dB 
dynamic range, 14 bits of resolution, and 10 MHz of modulation bandwidth.

The N8221A IF digitizer is based on industry leading Agilent PSA Series spectrum 
analyzers and is one of the many synthetic instrument (SI) modules offered by Agilent 
Technologies. An SI module itself may not perform complex measurements, but when 
combined with other SI modules, they form instruments that can execute all of the 
functions of a traditional ATE system. By working with the Test Program Set, which 
defines the type of measurements and the sequence of those measurements required for a 
particular military application, SI module software can be written to meet the needs of 
many different military electronic systems with a common SI test platform. 

Agilent’s SI modules use LAN eXtension for Instrumentation (LXI) modular format. 
LXI differs from other modular formats (such as VXI and PXI) by using an external 
computer and local area network (LAN), rather than embedded computers, for control. 

The LXI standard supports the IEEE 1588 time synchronization and protocol standard, 
which allows synchronous triggering of different instruments, even with different-length 
LAN cables. The IEEE 1588 precision time protocol (PTP) enables a common sense of 
time over a distributed system. 

SI modules offered by Agilent Technologies include the following:

• N8201A performance downconverter, 3 Hz to 26.5 GHz

• N8211A performance analog upconverter, 250 kHz to 20 / 40 GHz

• N8212A performance vector upconverter, 250 kHz to 20 GHz

• N8221A IF digitizer, 30 MS/s

• N8241A arbitrary waveform generator, 15-Bit, 1.25 GS/s or 625 MS/s

• N8242A arbitrary waveform generator, 10-Bit, 1.25 GS/s or 625 MS/s

For further information, refer to:

http://www.agilent.com/find/synthetic
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User’s Guide
1
Software Installation

“Before Installing Software and Instrument Drivers" on page 10

“Installing Agilent I/O Libraries" on page 11

“Installing Agilent I/O Libraries Update (Patch)" on page 13

“Installing IVI Shared Components" on page 14

“Installing IVI-COM Drivers" on page 15

“Installing the Synthetic Instrument Graphical User Interface" on page 16

“Installing the Agilent N8221A IF Digitizer User Interface" on page 17

“Installing the Synthetic Instrument Finder" on page 18
9Agilent Technologies



1 Software Installation
Before Installing Software and Instrument Drivers

Verify the PC Meets Minimum Requirements
10
• 1 GHz Intel Pentium processor 

• Microsoft Windows XP Professional or Home Edition (Service Pack 1 or 2), 
Windows 2000 (Service Pack 2) 

• 512 MB of RAM 

• Up to 40 MB of available hard-disk space 

• Microsoft Internet Explorer 6.0 (or higher)

The following software and instrument drivers are required to operate the 
N8221A IF digitizer.
CAUTION If the following software or instrument drivers are installed on the PC to be used, uninstall 
them and install the software and drivers shipped on the 
Agilent N8221A IF Digitizer Synthetic Instrument Module, 30 MS/s Instrument Drivers and 
Documentation CD (N8221-90001). 
 
The CD contains the following:

• Agilent I/O Libraries
• Agilent I/O Libraries Update (Patch)
• IVI Shared Components
• IVI-COM Drivers
• Synthetic Instrument’s Graphical User Interface
• Agilent N8221A IF Digitizer User Interface
• Synthetic Instrument Finder
1 Place the Agilent N8221A IF Digitizer Synthetic Instrument Module, 30 MS/s 
Instrument Drivers and Documentation CD into the CD-ROM drive.
NOTE Prior to continuing this installation procedure, install Adobe Acrobat Reader 5.0 or later on 
your PC. The software is included on the Agilent N8221A IF Digitizer Synthetic Instrument 
Module, 30 MS/s Instrument Drivers and Documentation CD.

Click Adobe Acrobat Reader 5.0 to install the software.
2 Click Instrument Drivers.
Agilent N8221A IF Digitizer Synthetic Instrument Module, 30 MS/s



Software Installation 1
Installing Agilent I/O Libraries
Agilent N8221A IF Dig
3 Select 1. Agilent I/O Libraries on the Software and Driver Installation page. 
It takes about 10 seconds for the application to run. 
  

4 Click the check box, “Do not show this message again” so that the check box is 
selected. 

5 Click Open.

6 Follow the Agilent I/O installation instructions, accepting the default settings until 
the Finish dialog box should appear. 
itizer Synthetic Instrument Module, 30 MS/s 11
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1 Software Installation
 

7 Click the check box, “Yes, I want to connect to my instrument. Launch Agilent 
Connection Expert.”, so that the check box is not selected. 

8 Click Finish.
Agilent N8221A IF Digitizer Synthetic Instrument Module, 30 MS/s



Software Installation 1
Installing Agilent I/O Libraries Update (Patch)
Agilent N8221A IF Dig
9 Select 2. Agilent I/O Libraries Update (Patch) on the Software and Driver 
Installation page. 
 

10 Follow the Agilent I/O Libraries Update (Patch) installation instructions, accepting 
the default settings.

11 Click Finish.
itizer Synthetic Instrument Module, 30 MS/s 13



1 Software Installation
Installing IVI Shared Components
14
12 Select 3. IVI Shared Components on the Software and Driver Installation page. 
  

13 Follow the IVI Shared Components installation instructions, accepting the default 
settings.

14 Click Finish.
Agilent N8221A IF Digitizer Synthetic Instrument Module, 30 MS/s



Software Installation 1
Installing IVI-COM Drivers
Agilent N8221A IF Dig
15 Select 4. IVI-COM Drivers on the Software and Driver Installation page. 
 

16 Follow the IVI-COM installation instructions, accepting the default settings.

17 Click Finish.
itizer Synthetic Instrument Module, 30 MS/s 15



1 Software Installation
Installing the Synthetic Instrument Graphical User Interface
16
18 Select 5. Synthetic Instrument’s Graphical User Interface on the Software and 
Driver Installation page. 
 

19 Follow the Synthetic Instrument’s Graphical User Interface installation instructions, 
accepting the default settings.

20 Click Close.
Agilent N8221A IF Digitizer Synthetic Instrument Module, 30 MS/s



Software Installation 1
Installing the Agilent N8221A IF Digitizer User Interface
Agilent N8221A IF Dig
21 Select 6. Agilent N8221A IF Digitizer User Interface on the Software and Driver 
Installation page. 
 

22 Follow the N8221A IF Digitizer User Interface installation instructions, accepting 
the default settings.

23 Click Close.
itizer Synthetic Instrument Module, 30 MS/s 17



1 Software Installation
Installing the Synthetic Instrument Finder
18
24 Select 7. Synthetic Instrument Finder on the Software and Driver Installation page. 
 

25 Follow the Synthetic Instrument Finder installation instructions, accepting the 
default settings.

26 Click Close and exit the CD-ROM. The installation is complete!
Agilent N8221A IF Digitizer Synthetic Instrument Module, 30 MS/s



User’s Guide
2
Hardware Setup and Configuration

“Step 1. Unpacking the N8221A IF Digitizer" on page 20

“Step 2. Connecting to a LAN" on page 21

“Step 3. Turning on Power" on page 23

“Step 4. Verifying Connectivity to the PC" on page 24

“(Optional) Verifying Connectivity with the Synthetic Instrument 
Finder" on page 25

“Troubleshooting"

• “How to Use the Synthetic Instrument Finder" on page 28

• “How to Reset the LAN Configuration" on page 32

• “How to Set a Static IP Address" on page 33

• “How to Troubleshoot Connectivity Problems on the Network" on page 38

• “How to Determine a PCs Configuration Settings" on page 39

• “If the instrument was unable to join the LAN" on page 40

• “If the LAN LED is red" on page 40”

• “If the instrument’s IP address or hostname cannot be found with Ping" on page 41

• “If the instrument is not found by the Synthetic Instrument Finder" on page 41”

• “If the PC cannot communicate with the instrument using the hostname" on page 41”

• “If the instrument Web page is not visible" on page 42”

• “If the software driver will not open the connection" on page 42”
19Agilent Technologies



2 Hardware Setup and Configuration
Step 1. Unpacking the N8221A IF Digitizer

WARNING The unique shape of the N8221A IF digitizer was intended to allow multiple instruments 
to reside in a compact system that is both modular and transportable. With instruments 
adjacent to each other, handles could not be installed on the respective instruments. 
Exercise caution when lifting and carrying the instrument to avoid personal injury. At 
nearly 20 pounds (9 kilograms), it is recommended that two people be utilized for 
instrument lifting and transport. 
20
NOTE Verify that any options ordered are included with the shipment by checking the packing 
literature included with the shipment.

The serial number label on the N8221A IF digitizer only verifies hardware/firmware 
options. The packing literature verifies all items shipped.
Verify the Shipment
1 Inspect the shipping container for damage. 
 
Signs of damage may include a dented or torn shipping container or cushioning 
material that shows signs of unusual stress or compacting. 

2 Carefully remove the contents from the shipping container and verify that the order is 
complete. 

The following items are shipped standard with each N8221A IF digitizer:

• instrument drivers, synthetic graphical user interface, and documentation 
CD-ROM (p/n N8221-90001)

• three-prong AC power cord specific to geographic location 
(Optional) Prepare the Instrument for Rack Mounting

CAUTION If the N8221A IF digitizer is to be placed in a system rack, the feet currently 
attached can be replaced with the rack mount feet (part number W1312-40032) 
supplied with the accessories. Failure to do so can result in a safety issue.
Agilent N8221A IF Digitizer Synthetic Instrument Module, 30 MS/s



Hardware Setup and Configuration 2
Step 2. Connecting to a LAN

Before Connecting to a LAN
Agilent N8221A IF Dig
Before connecting to a LAN, verify your local policy by contacting the system 
administrator in your Information Technology (IT) department and inquire about 
connecting instruments to the LAN. 

• If the network uses DHCP [Dynamic Host Configuration Protocol], an address is 
assigned to the device automatically. If you need to know what the IP address is, it 
can be determined using the Synthetic Instrument Finder. (Refer to “How to Use the 
Synthetic Instrument Finder" on page 28.) 
 
If no DHCP is present, but the instrument is set to use DHCP (the default), the 
instrument waits two minutes for its DHCP request to time out. When the 
N8221A IF digitizer is used in this situation, there is a time delay of approximately 
three minutes between the time of when the N8221A IF digitizer’s power is turned on 
and when it is available for use. 
 
If the network does not use DHCP, you can use Auto IP or configure your LAN 
settings manually. Although you can also manually configure LAN settings in a 
network with DHCP, it is recommended that you do so with the assistance of your 
system administrator. 

• If the network uses Auto IP (does not use DHCP), the N8221A IF digitizer acquires a 
169.254.X.X address.
itizer Synthetic Instrument Module, 30 MS/s 21



2 Hardware Setup and Configuration
Select one of the following two configurations:
22
• Connect a LAN cable from the LAN connector on your PC to an empty connector on 
your internal local area network or LAN hub. Connect a LAN cable from the LAN 
connector on the rear panel of the N8221A IF digitizer to an empty connector on your 
internal local area network or LAN hub. 
Figure 1 Connecting the PC LAN cable to a company/private LAN to the instrument LAN

• Connect a cross-over cable from the LAN connector on your PC to the LAN 
connector on the rear panel of the N8221A IF digitizer.
Figure 2 Connecting the PC LAN cable to the instrument LAN (cross-over cable)
Agilent N8221A IF Digitizer Synthetic Instrument Module, 30 MS/s



Hardware Setup and Configuration 2
Step 3. Turning on Power
Agilent N8221A IF Dig
1 Turn on power to the N8221A IF digitizer and wait until the LAN LED turns solid 
green; this takes about 60 seconds. This can take up to four minutes depending on 
whether the instrument is using DHCP or Auto IP.

2 Turn on power to the PC.
itizer Synthetic Instrument Module, 30 MS/s 23



2 Hardware Setup and Configuration
Step 4. Verifying Connectivity to the PC
24
To verify the connectivity between the N8221A IF digitizer and the PC:

1 Verify that the LAN LED on the N8221A IF digitizer’s rear panel is green or blinking 
green. This indicates a good connection. 
 
If the LED is off, there is a problem with your LAN connection. 

2 Verify that the LAN LED on the N8221A IF digitizer’s front panel (next to the LAN 
port) is solid green. 
 
If the LED turns red, this indicates a problem with your LAN connection. This takes 
approximately 60 seconds. 

3 (Optional) Ping the N8221A IF digitizer from the PC.

a From the Windows Desktop, select Start > Run.

b At the Open prompt, type CMD and press Enter to open a DOS window.

c At the command prompt, type Ping and the instrument’s IP address (for example, 
Ping 141.121.84.108.) or type Ping and the instruments hostname (for 
example, Ping a-n8221a-80179).
Agilent N8221A IF Digitizer Synthetic Instrument Module, 30 MS/s



Hardware Setup and Configuration 2
(Optional) Verifying Connectivity with the Synthetic Instrument Finder
Agilent N8221A IF Dig
Agilent supplies a program named the Synthetic Instrument Finder that enables 
connection between a PC and instruments that are connected on a LAN [Local Area 
Network]. (For further details, refer to “Troubleshooting" on page 28.)

1 From the Windows Desktop, click Start > All Programs > Agilent SI Tools > Synthetic 
Instrument Finder.

The Synthetic Instrument Finder should appear and look similar to the following.
itizer Synthetic Instrument Module, 30 MS/s 25
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2 Hardware Setup and Configuration
2 In the left-hand pane of the Synthetic Instrument Finder, right-click the 
N8221A IF digitizer and the following menu should appear. 

 

3 Select Open Webpage and a Web browser should appear that allows viewing and 
modifying settings for instruments on the network. If this Web page opens, you have 
verified connectivity.
Agilent N8221A IF Digitizer Synthetic Instrument Module, 30 MS/s



Hardware Setup and Configuration 2

Agilent N8221A IF Dig
4 (Optional) Select Open with Synthetic GUI and the Synthetic Instrument GUI 
should appear; this GUI allows you to control the settings on the selected instrument. 
If the Agilent Synthetic Instrument GUI opens, you have verified connectivity.

.

itizer Synthetic Instrument Module, 30 MS/s 27



2 Hardware Setup and Configuration
Troubleshooting

How to Use the Synthetic Instrument Finder
28
Agilent supplies a program named the Synthetic Instrument Finder that enables 
connection between a PC and instruments that are connected on a LAN [Local Area 
Network].

1 Click Start > All Programs > Agilent SI Tools > Synthetic Instrument Finder to open the 
Synthetic Instrument Finder program. 

2 In the left-hand pane of the Synthetic Instrument Finder, right-click the 
N8221A IF digitizer and the following menu should appear. 
Agilent N8221A IF Digitizer Synthetic Instrument Module, 30 MS/s



Hardware Setup and Configuration 2

Agilent N8221A IF Dig
The Synthetic Instrument Finder window is divided into two main sections:

• right pane contains information specific to the instrument highlighted in the left pane.

• left pane contains a list of equipment available on your LAN for connection.

Right-Pane Functions

Send Settings  Sends the current instrument settings to the N8221A IF digitizer. Use 
this function if you modified the settings in Instrument Finder.

5 Second Identify Flashes the LAN LED for five seconds. 

Turn On Ident LED  When On, the LAN LED continuously flashes on and off. Once the 
Turn On Ident LED button is pressed, the button name changes to Turn Off Ident LED.

Refresh List Updates the device’s list.

Continuous Refresh Updates the device’s list every one minute.

Add Device Manually Allows you to add a device for connection. Use this feature 
only if your instrument does not appear in the Devices list.

a Click Add Device Manually. The Devices area will display a new listing titled 
“Unknown”.

b In the Manual settings area, enter in the MAC address, serial number, and model 
number of the device.

c In the LAN settings area, enter in the information for the new device. (Make sure 
that you scroll down the list to get to the editable settings area.)

d Click Send Settings to enter this information in the Devices area.

e Double-click the new listing to open the webpage, or right-click and select Open 
using Synthetic GUI to use the virtual interface.
itizer Synthetic Instrument Module, 30 MS/s 29
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2 Hardware Setup and Configuration
Left-Pane Functions

In the left pane, right-click on the N8221A IF digitizer and the following menu should 
appear. 

Interactive IO Opens the Agilent Interactive IO application which allows SCPI 
commands to be sent to the instrument. (The Interactive IO option is only available if the 
Agilent Connection Expert has been installed on the PC.)

Open Webpage Opens the Web page associated with the currently selected instrument. 
From this Web page, settings for the instrument can be viewed and modified.

Tip:  There are two other ways to access the device’s Web page:

• By double-clicking on the Device listing in the Synthetic Instrument Finder.

• By typing in the device’s hostname or IP address in your Internet browser.
Open using Synthetic GUI Opens the Synthetic Instrument GUI.
Agilent N8221A IF Digitizer Synthetic Instrument Module, 30 MS/s



Hardware Setup and Configuration 2

Agilent N8221A IF Dig
Copy VISA Address to Clipboard (IP Address) Copies the VISA IP address to the 
clipboard for use in other applications.

Copy VISA Address to Clipboard (Hostname) Copies the VISA hostname to the 
clipboard for use in other applications. It is recommended that you use this address on 
networks with DHCP and DNS network capability.
itizer Synthetic Instrument Module, 30 MS/s 31



2 Hardware Setup and Configuration
How to Reset the LAN Configuration
32
On the instrument front panel, near the power switch, is a recessed button labeled 
“RESET”. This button enables you to place the LAN configuration of the instrument 
into a known state. 

When this button is pressed (a straightened paper clip will do the job) the following 
settings are made and the system reboots.

• IP address is set to 192.168.EE.FF, where EE and FF are the last two parts of the 
MAC address (AA.BB.CC.DD.EE.FF). This is designed to prevent multiple 
instruments from using the same default IP address (refer to the instrument label).

• Subnet Mask is set to 255.255.0.0

• DHCP is set to on

• Auto IP is set to on
NOTE If you had manually configured LAN settings before, you may have to reconfigure your 
instrument to reset DHCP and Auto IP to OFF. Refer to “How to Set a Static IP Address" on 
page 33.
• The instrument hostname is set to A-N82XXA-NNNNN, where N82XXA is the 
instrument model number (such as N8221A) and NNNNN represents the last five 
digits of the instrument serial number.

If the instrument is in an environment with a DHCP server, it is assigned an IP address 
through DHCP. The IP address can be found by using the instrument hostname as the 
URL in a web browser.

Without DHCP, the instrument will use Auto IP and acquire a 169.254.X.X address. If 
no DHCP is present, but the instrument is set to use DHCP (the default), the instrument 
will wait two minutes for its DHCP request to time out. In this case, there is a time delay 
of approximately three minutes between when the instrument is powered on and when it 
is usable.

Recessed
LAN RST
Button
Agilent N8221A IF Digitizer Synthetic Instrument Module, 30 MS/s



Hardware Setup and Configuration 2
How to Set a Static IP Address
Agilent N8221A IF Dig
The DHCP server automates the process of setting up the IP addresses on your network 
by default. When the N8221A IF digitizer is turned on, it searches for a DHCP server on 
the network and selects a “dynamic IP address”. Each time the N8221A IF digitizer is 
rebooted, the N8221A IF digitizer may get a different IP address. To set the 
N8221A IF digitizer to a static IP address, rather than allowing the DHCP server to 
select an auto IP address:

1 Assign a N8221A IF digitizer instrument IP address that will work with your 
computer.
F

NOTE For a company wide network, your system administrator will have to assign an IP address 
that is compatible with your PC. If you have a private LAN network or a direct connection 
from your PC to the instrument, you can assign the IP address. Refer to “Step 1. Unpacking 
the N8221A IF Digitizer" on page 20.
itizer Synthetic Instrument Module, 30 MS/s 33
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2 Hardware Setup and Configuration
2 Connect the N8221A IF digitizer in one of the following two configurations:

• Connect a LAN cable from the LAN connector on your PC to an empty connector 
on your internal local area network or LAN hub. Connect a LAN cable from the 
LAN connector on the rear panel of the N8221A IF digitizer to an empty 
connector on your internal local area network or LAN hub. 
Figure 3 Connecting the PC LAN cable to a company/private LAN to the instrument LAN

• Connect a cross-over cable from the LAN connector on your PC to the LAN 
connector on the rear panel of the N8221A IF digitizer.
Figure 4 Connecting the PC LAN cable to the instrument LAN (cross-over cable)

3 Turn on power to the PC.
Agilent N8221A IF Digitizer Synthetic Instrument Module, 30 MS/s



Hardware Setup and Configuration 2

Agilent N8221A IF Dig
4 Turn on power to the N8221A IF digitizer and wait until the LAN LED turns solid 
green; this takes about 60 seconds.

5 From the Windows Desktop, click Start > All Programs > Agilent SI Tools > Synthetic 
Instrument Finder.

The following Synthetic Instrument Finder dialog box should appear.
itizer Synthetic Instrument Module, 30 MS/s 35
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2 Hardware Setup and Configuration
6 Select the N8221A IF digitizer listed in the Agilent Synthetic Instrument Finder 
dialog box to access the N8221A IF digitizer Web page.
Agilent N8221A IF Digitizer Synthetic Instrument Module, 30 MS/s



Hardware Setup and Configuration 2

Agilent N8221A IF Dig
7 Click View & Modify LAN Config in the left-pane of the Web page. The following 
dialog box should appear.

8 Click Modify Configuration to access the Password dialog.
itizer Synthetic Instrument Module, 30 MS/s 37
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2 Hardware Setup and Configuration
9 Click Submit (accept the default password) and the following dialog box should 
appear. The default password is set to “agilent”. 

Tip: You can change the password from the View & Modify LAN Connections. (Scroll 
down the Parameter column until you locate the Change Password parameter.)
10 Change the DHCP and Auto IP radio-buttons to Off. Change the IP address, Subnet 
Mask, and Default Gateway values to meet your network requirements.

11 Click Save to save the new settings. Parameters marked with an asterisk (*) also 
require that you click "Renew LAN settings" before changes take effect.
How to Troubleshoot Connectivity Problems on the Network

NOTE For the new settings to become effective, you may first cycle the power of the instrument 
and then cycle the power of the PC.
The Synthetic Instrument Finder program is used to find instruments on a network when 
the N8221A IF digitizer is connected through a router or cross-over cable. There are 
three possible configurations: 

• connecting the PC through a company wide site LAN connection to the 
N8221A IF digitizer

• connecting the PC to the same private LAN network as the instrument

• connecting the PC directly to the instrument using a cross-over cable - this would 
typically be used for troubleshooting and is not normally used to control an 
instrument directly
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Agilent N8221A IF Dig
The N8221A IF digitizer is shipped with a default IP address. This default IP address is 
192.168.EE.FF, where EE and FF are the last two parts of the Media Access Control 
(MAC) address (AA.BB.CC.DD.EE.FF).
How to Determine a PCs Configuration Settings
From a DOS Window

1 From the Windows Desktop, click Start > Run.

2 At the Open: prompt, type CMD and press Enter to open a DOS window.

3 At the command prompt, type ipconfig/all to display the PCs network 
connection details.

Or,

From the PCs Control Panel

1 From the Windows® Desktop, click Start > Settings > Control Panel > Network 
and Internet Connections.

2 From the Network and Internet Connections window, double-click the Local Area 
Connection.

3 In the Local Area Connection Status dialog, click the Support tab and click Details 
to display the PCs Network Connection Details.

The Network Connection Details include:

• Physical Address

• DHCP status, enabled or disabled (displayed when using the DOS window 
ipconfig command only)

• Auto configuration enabled or disabled (displayed when using the DOS window 
ipconfig command only)

• IP Address

• Subnet Mask

• Default Gateway

• DHCP Server Address

• Lease Obtained

• Lease Expired

• Primary WINS Servers

• Secondary WINS Servers
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If the instrument was unable to join the LAN
40
or
If the LAN LED is red

Symptom

Possible Causes Possible Solutions

The instrument is not connected to a LAN. If connecting the instrument to a switch or hub, verify 
that the instrument is connected with a standard LAN 
cable.

An incorrect LAN cable is being used. • If connecting the instrument directly to a PC, verify 
that the instrument is connected with a cross-over 
cable.

• If connecting the instrument to a switch or hub, 
verify that the instrument is connected with a 
standard LAN cable.

The device’s LAN port is not active. Connect the instrument to a known working LAN 
port.

The device is configured to use DHCP, but no DHCP 
server is available.

• Disable DHCP. Refer to “How to Set a Static IP 
Address" on page 33.

• Connect the device to a LAN that uses a DHCP 
server.

The instrument is configured to use a duplicate static 
IP address.

• Make sure that no other device is using the same 
IP address as your instrument.

• Configure your instrument to use a different IP 
address. Refer to “How to Set a Static IP 
Address" on page 33.
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If the instrument’s IP address or hostname cannot be found with Ping

If the instrument is not found by the Synthetic Instrument Finder

If the PC cannot communicate with the instrument using the hostname

Possible Causes Possible Solutions

The instrument was unable to join the LAN. See “If the instrument was unable to join the 
LAN" on page 40.

The instrument’s LAN settings are incorrect. Verify that the instrument’s settings are appropriate 
for your LAN. 

A firewall is preventing communication between your 
PC and your instrument.

Make sure that your firewall settings allow 
communication between your PC and other devices.

The instrument is using Auto-IP (That is, the 
instrument assigned itself a 169.254.x.x IP address) 
and your PC is not using Auto IP (That is, PC does not 
have a 169.254.x.x IP address.)

• Disable Auto-IP on the instrument. 
• Configure your PC to use Auto-IP.

Possible Causes Possible Solutions

The instrument was unable to join the LAN. See “If the instrument was unable to join the 
LAN" on page 40.

The instrument and PC are on different 
switches/hubs and different subnets.

• Put the instrument on the same switch or hub as 
your PC.

• If the instrument is using DHCP, make sure that the 
instrument and the PC are put on the same subnet.

• If the instrument is using a static IP address, make 
sure that the instrument IP address and subnet 
mask put the instrument on the same subnet as 
your PC.

Possible Causes Possible Solutions

No DNS server is available. Communicate with the instrument using the 
instrument’s IP address.

The DNS server has not been updated. Wait several minutes.

Your PC cannot communicate with the device over 
your LAN.

See “If the instrument’s IP address or hostname 
cannot be found with Ping" on page 41.
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If the instrument Web page is not visible

If the software driver will not open the connection

Possible Causes Possible Solutions

• The instrument has not yet joined the LAN.
• The instrument is unable to join the LAN.

See “If the LAN LED is red" on page 40.

Your PC cannot communicate with the device over 
your LAN.

See “If the instrument was unable to join the 
LAN" on page 40.

You are attempting to use the device’s hostname and 
the hostname is not working.

See “If the PC cannot communicate with the 
instrument using the hostname" on page 41.

Your browser is configured to use a proxy, and the 
proxy does not allow communication with 
instruments on the LAN. 

Disable or reconfigure the proxy settings. Open 
Internet Explorer and select Tools > Internet Options 
> Connections > LAN Settings… 

Possible Causes Possible Solutions

Your PC cannot communicate with the device over 
your LAN.

See “If the instrument’s IP address or hostname 
cannot be found with Ping" on page 41.

Someone else is currently connected to the 
instrument.

Make sure that no one else is connected to the 
instrument.
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3
Using the Synthetic Instrument GUI

“Starting the Agilent Synthetic Instrument GUI" on page 44

“Overview of the Agilent Synthetic Instrument GUI" on page 46

“Main Menu of the Agilent Synthetic Instrument GUI" on page 47

“N8221A IF Digitizer Property Settings" on page 53
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Starting the Agilent Synthetic Instrument GUI
44
This section describes how to access and use the Agilent Synthetic Instrument GUI.

1 From the Windows Desktop, click Start > All Programs > Agilent SI Tools > 
Agilent Synthetic Instrument GUI to access the Agilent Synthetic Instrument GUI.

Figure 5 Agilent Synthetic Instrument GUI Menu Access Path

Figure 6 Agilent Synthetic Instrument GUI Start Page

2 Click the applicable N8221A IF digitizer from the Recent Connections are of the 
Agilent Synthetic Instrument GUI.

If this is the first time you are accessing the Agilent Synthetic Instrument GUI, (in the 
lower-left corner of the dialog box) click Connection Manager and from the Connect to 
Instruments dialog box, click Find Instruments. This should display a list of all 
available instruments on the LAN hub. From this list, select the N8221A IF digitizer.
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Agilent N8221A IF Dig
3 A window similar to the following should appear.

Figure 7 Agilent Synthetic Instrument GUI, N8221A IF Digitizer Settings Page

For descriptions on the Synthetic Instrument GUI settings refer to, Using the Synthetic 
Instrument GUI” on page 53.
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Overview of the Agilent Synthetic Instrument GUI
46
The Agilent Synthetic Instrument GUI is divided into two main areas: the left pane and 
right pane.
Figure 8 N8221A IF Digitizer GUI
Left Pane
The lower portion of the left pane displays the settings available for adjustment on the 
N8221A IF digitizer. Click a function button to activate that function and the related 
functions are displayed in the Properties area. For example, in Figure 8, IF Bandwidth 
is the active function. All settings associated with IF Bandwidth are available for 
modification. (That is: Auto Range Mode, Acquisition Points, Acquisition Time, IF BW 
Type, ADC Range, and Dither Mode.) Here, you can make adjustments to any of these 
settings.
Right Pane
The upper portion of the right pane always displays the functions that are most 
commonly used for a measurement. These functions are also accessible from the left 
pane. Changing one of these parameters changes the setting in the left pane as well.

The lower portion of the right pane has three tabs: Dynamic Help, Instrument 
Information, and the Event Log. For more information on theses areas, refer to 
“Dynamic Help" on page 50, “Instrument Information" on page 52, and “Event Log" on 
page 52.
Agilent N8221A IF Digitizer Synthetic Instrument Module, 30 MS/s



Using the Synthetic Instrument GUI 3
Main Menu of the Agilent Synthetic Instrument GUI

File Menu
Agilent N8221A IF Dig
The File menu accesses options for instrument connection, save and recall settings, and 
exiting the application. Theses tasks are also available by clicking the icons on the tool 
bar.

Figure 9 File sub menu 

Connect 

Accesses the Connect to Instrument dialog box which is used to connect to an instrument 
on the LAN hub.

Figure 10 Connect to Instrument window

Reconnect 

Re-establishes the connection to the instrument if the instrument has been disconnected.
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Disconnect

Terminates the connection to the active instrument that is using the Synthetic Instrument 
GUI.

Load Settings

Accesses the Load Instrument Properties dialog box where you can recall user-definable 
instrument settings.

Save Settings

Accesses the Save Instrument Properties dialog box where you can save instrument 
settings for use at a later time.

Exit 

Closes the Agilent Synthetic Instrument GUI application.
Help
The Help menu displays the current versions of the GUI and drivers.

Figure 11 Help About Synthetic GUI
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Tabbed Pages, Left Pane
Agilent N8221A IF Dig
Start Page

The Start Page lists the instruments previously connected to the Agilent Synthetic 
Instrument GUI. 

Connection Manager Accesses the Connect to Instrument dialog box.

Saved Connections Accesses user defined connections.

Recent Connections Displays a list of instruments that have recently been controlled 
by the Agilent Synthetic Instrument GUI.

Connection Expert Accesses Agilent Connections Expert.

Find Instruments Lists the instruments found in Instrument Finder.

Test  Tests the connection between the PC and the highlighted instrument.
Error Log
Displays a history of all instrument and GUI related errors and messages.

Figure 12 Error Log
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Accesses the settings available for modification for the active instrument.

Figure 13 Upconverter properties
Tabbed Pages, Right Pane
The upper portion of the right pane always displays the functions that are most 
commonly used for a measurement. These functions are also accessible from the left 
pane. Changing one of these parameters changes the setting in the left pane as well.

The lower portion of the right pane has the following tabs: Dynamic Help, Instrument 
Information, and Event Log.

Dynamic Help

Provides information about the function currently selected in the left pane. In Figure 13, 
IF Bandwidth is the active function.
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Agilent N8221A IF Dig
Figure 14 Dynamic Help 
itizer Synthetic Instrument Module, 30 MS/s 51



52

3 Using the Synthetic Instrument GUI
Instrument Information

Provides information about your N8221A IF digitizer such as the serial number, 
IP address, software revision used, and so on.
Figure 15 Instrument Information page

Event Log

When enabled in the Events parameters area, displays the event log history.

Figure 16 Event Log page
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N8221A IF Digitizer Property Settings

IF Bandwidth
Agilent N8221A IF Dig
Sets the device IF Bandwidth.

Limits: 1.000 Hz to 10.000000000 MHz
Auto Range Mode
Sets the Auto Range Mode.

Possible Values: Off,  Auto,  Lock,  Normal,  Peak Hold
Acquisition Points
Sets the number of Acquisition Points.

Limits: 2 to 65536
ADC Range
Sets the ADC Range.

Limits: 0 to 3
Trace Type
Sets the Trace Type.

Possible Values: Spectrum, Raw Time, Main Time
itizer Synthetic Instrument Module, 30 MS/s 53
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Window
54
Sets the FFT Window.

Enabled: Can be set if Trace Type equals Spectrum.

Possible Values: Hanning, Uniform, Gaussian, Flat Top
Average Type
Sets the Average Type that is used for averaging.

Enabled: Can be set if Trace Type equals Main Time or if Trace Type equals Spectrum.

Possible Values:

• No Averaging

• Maximum (Available if Trace Type equals Spectrum)

• Minimum (Available if Trace Type equals Spectrum)

• RMS (Available if Trace Type equals Spectrum)

• Time (Available if Trace Type equals Main Time)
Average Count
Sets the Average Count.

Enabled: Can be set if Average Type does not equal No Averaging.

Limits: 2 to 1000
Display Holdoff
Sets the Display Holdoff value.

Limits: 50.00 ms to 60.00 s
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Trigger Setup (Grouped Values)
Agilent N8221A IF Dig
Sets up the acquisition trigger.
Trigger Source
Sets the source of triggers. When the specified trigger occurs, the instrument will move to 
the next frequency in its frequency list.

Possible Values:

Free Run, EXT - TTL, LXI0, LXI1, LXI2, LXI3, LXI4, LXI5, LXI6, LXI7, LAN0, LAN1, LAN2, LAN3, 
LAN4, LAN5, LAN6, LAN7, ALARM0
Trigger Detection
Sets the trigger polarity. It is Positive to trigger on a rising edge and Negative to trigger on a 
falling edge.

Visibility: Visible if Trigger Source does not equal Free Run.

Possible Values: Rising Edge, Falling Edge
Alarm Mode
Sets the way that Alarm Time will be interpreted. In absolute mode, the alarm will begin 
firing at the time of day specified in Absolute Alarm Time. In relative mode, the alarm will 
begin firing at a time relative to when the alarm is set up.

Visibility: Visible if Trigger Source equals ALARM0

Possible Values: Relative, Absolute
Relative Alarm Time
Sets the number of seconds after pressing Execute Trigger that the first alarm will occur.
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Visibility: Visible if Trigger Source equals ALARM0 and if Alarm Mode equals Relative.

Limits: 0.000000 s to 3600.000000000 s
Absolute Alarm Time
Sets the time that the first alarm will occur.

Visibility: Visible if Trigger Source equals ALARM0 and if Alarm Mode equals Absolute.

Limits: 1/1/1970 12:00:00 AM to 1/1/2200 12:00:00 AM
Alarm Period
Sets the time between successive alarms.

Visibility: Visible if Trigger Source equals ALARM0.

Limits: 0.000000 s to 3600.000000000 s
Alarm Repeat
Sets the number of times the alarm will be repeated. A value of 1 means that the alarm will 
occur once and will not be repeated. A value of 2 means that the alarm will occur twice. A 
value of 0 means that the alarm will be repeated until the alarm is disabled.

Visibility: Visible if Trigger Source equals ALARM0.

Limits: 0   to   1000000000
Execute Trigger
Sends the new trigger settings to the instrument.
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Actions
Agilent N8221A IF Dig
Single Sweep
Specifies Single Sweep mode so that the instrument will stop after completing one sweep.
Toggle Continuous Sweep
Starts or stops a Continuous Sweep.
Abort Sweep
Aborts the current sweep.
itizer Synthetic Instrument Module, 30 MS/s 57
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Front and Rear Panel Connectors

“N8221A IF Digitizer Front and Rear Panel Features" on page 61

“Interconnect Cabling" on page 64

“Operational Considerations" on page 65
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4 Front and Rear Panel Connectors
Figure 17 N8221A IF digitizer front panel

Figure 18 N8221A IF digitizer rear panel
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N8221A IF Digitizer Front and Rear Panel Features

Front Panel Features
Agilent N8221A IF Dig
10 MHz REF IN

This SMB (male) connector accepts a 10 MHz reference signal for clock 
synchronization. This input accepts TTL compatible signal levels. The input 
is DC- coupled with 50 Ω input impedance.

10 MHz REF OUT

This SMB (male) connector outputs a 10 MHz reference signal, based on 
the units internal clock. The output signal is TTL compatible, DC- coupled, 
and 50 Ω output impedance. Nominal output power is +8 dBm.

TRIGGER IN

This SMB (male) connector accepts input triggers to the 
N8221A IF digitizer at TTL signal levels. This input is DC- coupled with 
1 KΩ input impedance.

TRIGGER OUT

This SMB (male) connector outputs a trigger from the N8221A IF digitizer. 
The output signal is TTL compatible, DC- coupled and 50 Ω output 
impedance.

30 MHz EXT CLOCK IN

This SMB (male) connector accepts a 30 MHz external clock reference 
input. It uses a AC comparator with 1 KΩ input impedance. This connector 
accepts TTL, ECL, or >- 6 dBm sine waves.

30 MHz EXT CLOCK OUT

This SMB (male) connector outputs the 30 MHz internal clock reference 
signal. The output signal is TTL compatible, DC- coupled and 1 KΩ output 
impedance.

IF INPUT

This SMB (male) connector accepts a 7.5 MHz IF input signal. The nominal 
input impedance is 50 Ω .

Power Switch

This switch offers a switching function between a power standby state and 
the power on state.
itizer Synthetic Instrument Module, 30 MS/s 61
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Rear Panel Features
AC Power Receptacle

The AC voltage is connected here. The power cord receptacle accepts a three-pronged 
power cable that is shipped with the N8221A IF Digitizer. The voltage range is 
100/120/220/240 volts with a frequency range of 50 to 60 Hz and is automatically selected 
by the power supply.

LXI Trigger Bus

The LXI (LAN eXtensions for Instrumentation) Trigger Bus is a hardware bus providing eight 
trigger channels using M-LVDS (low-voltage differential signaling). Cables connect various 
instruments together in a daisy chain or star configuration. Any instrument in a cluster can 
send or receive triggers on any of the channels.
NOTE For more information about the LXI Trigger Bus and LAN triggering, refer to the following 
“LXI Consortium” white papers on the “Agilent N8221A IF Digitizer Documentation CD”:

• White_Paper_1_The_Appliaction_of_IEEE_1588_to_Test_and_Measurement_System
• White_Paper_2_LXI_Triggering
• White_Paper_3_Wired_Trigger_Bus_Physical_Aspects
LAN - This LAN interface allows ethernet local area network communication 
through a 100BaseT LAN cable.

Trigger Bus Terminators

Trigger
Bus

Trigger
Bus

Trigger
Bus

Trigger
Bus

Trigger
Bus

Star Hub

Trigger
Bus

Trigger
Bus

Trigger
Bus

Trigger
Bus

Trigger
Bus

Trigger Bus Terminators

Star Daisy-chain 
Agilent N8221A IF Digitizer Synthetic Instrument Module, 30 MS/s



Front and Rear Panel Connectors 4

Agilent N8221A IF Dig
CAUTION Electrostatic discharge (ESD) can damage the highly sensitive components in your 
instrument. ESD damage is most likely to occur as the instrument is being installed 
or when cables are connected and disconnected. Protect the circuits from ESD 
damage by wearing a grounding strap that provides a high resistance path to 
ground. Alternately, ground yourself to discharge any static charge built-up by 
touching the outer shell of any grounded instrument chassis before touching the 
port connectors.
USB

This is not a functional connector.

DB-9

This connector is for factory testing only.
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Interconnect Cabling
64
Figure 19 Interconnect cabling for the N8201A performance downconverter/N8221A IF digitizer
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Operational Considerations
Agilent N8221A IF Dig
This section includes instructions for configuring a LAN interface to the 
Agilent Technologies N8201A performance downconverter and the 
N8221A IF digitizer. The instructions assume that the computer being used 
has a LAN card installed and is configured for TCP/IP protocol. 
Agilent 89601A Vector Signal Analysis Software
The Agilent Technologies 89601A vector signal analysis (VSA) software is 
the virtual instrument interface for the 
N8201A performance downconverter/N8221A IF digitizer and offers a wide 
range of troubleshooting tools for analyzing signals.
Configuring the Local Area Network (LAN) Interface
You must ensure that the IP addresses for your computer and 
N8201A performance downconverter/N8221A IF digitizer are compatible, 
then configure the LAN interface. The IP address consists of four groups 
of numbers separated by periods (for example 192.168.1.5).
To Change the IP Address on the N8221A IF Digitizer:

CAUTION The factory default IP address for the N8201A/N8221A is: 192.168.1.5. Changing the 
default IP address may cause the instruments to not communicate across the LAN.
To configure the IP address on the N8221A IF digitizer

Step Notes

1 Open Windows® Explorer •

2 Enter the current IP address of the digitizer 
into the address entry box. 

•

3 Click “GO” • The N8221A IF digitizer’s Welcome Page is 
displayed. NOTE: After loading the Welcome 
Page, the browser attempts to reload the 
Welcome Page using the hostname assigned 
to the digitizer. If the page cannot be located 
using the hostname, use Notepad to add the 
digitizer’s IP address and hostname to:C:\
WINNT\system32\drivers\etc\lmhosts file 
using Notepad. An example line in the 
1mhosts file: 100.100.100.99 digi99 Save the 
file and reload the Welcome Page using the 
IP address as done previously.
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4 Click View and Modify Configuration at the 
left of the displayed page.

• The Current Configuration page will be 
displayed.

5 Click Modify Configuration. If the password 
is still set to the default (“agilent”) click 
submit, otherwise, enter the password and 
click “Submit”.

• The Configuration Setup page will be 
displayed.

6 Find the IP address text box and enter the 
new IP address.

•

7 Click Save. •

8 When the save is complete, 
click Renew LAN Settings.

• When the command completes, the IP 
address will have changed.

9 Enter the new IP address in the browser’s 
address entry box and click “Go”.

• You may also want to edit your lmhosts file to 
reflect the change. See step 3.

To configure the IP address on the N8221A IF digitizer

Step Notes
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Preventive Maintenance

“Using, Inspecting, and Cleaning RF Connectors" on page 68”

“General Procedures and Techniques" on page 71

“Instrument Removal" on page 74”

“Instrument Installation" on page 76

This chapter provides preventative maintenance information, which should be reviewed 
prior to working with the Agilent system. This information applies to all 
Agilent-supplied instruments in the system and the system as a whole.
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Using, Inspecting, and Cleaning RF Connectors
68
Taking proper care of cables and connectors will protect your system’s ability to make 
accurate measurements. One of the main sources of measurement inaccuracy can be 
caused by improperly made connections or by dirty or damaged connectors.

The condition of system connectors affects measurement accuracy and repeatability. 
Worn, out-of-tolerance, or dirty connectors degrade these measurement performance 
characteristics. 
Repeatability
If you make two identical measurements with your system, the differences should be so 
small that they will not affect the value of the measurement. Repeatability (the amount of 
similarity from one measurement to another of the same type) can be affected by:

• Dirty or damaged connectors

• Connections that have been made without using proper torque techniques (this 
applies primarily when connectors in the system have been disconnected, then 
reconnected).
RF Cable and Connector Care

CAUTION Static-Sensitive Devices 
This system contains instruments and devices that are static-sensitive. Always take 
proper electrostatic precautions before touching the center conductor of any 
connector, or the center conductor of any cable that is connected to any system 
instrument. Handle instruments and devices only when wearing a grounded wrist or 
foot strap. When handling devices on a work bench, make sure you are working on 
an anti-static worksurface.
Connectors are the most critical link in a precision measurement system. These devices 
are manufactured to extremely precise tolerances and must be used and maintained with 
care to protect the measurement accuracy and repeatability of your system.

To extend the life of your cables or connectors:

• Avoid repeated bending of cables—a single sharp bend can ruin a cable instantly.

• Avoid repeated connection and disconnection of cable connectors. 

• Inspect the connectors before connection; look for dirt, nicks, and other signs of 
damage or wear. A bad connector can ruin the good connector instantly.

• Clean dirty connectors. Dirt and foreign matter can cause poor electrical connections 
and may damage the connector.

• Minimize the number of times you bend cables.
Agilent N8221A IF Digitizer Synthetic Instrument Module, 30 MS/s



Preventive Maintenance 5

Agilent N8221A IF Dig
• Never bend a cable at a sharp angle.

• Do not bend cables near the connectors.

• If any of the cables will be flexed repeatedly, buy a back-up cable. This will allow 
immediate replacement and will minimize system down time.

Before connecting the cables to any device:

• Check all connectors for wear or dirt. 

• When making the connection, torque the connector to the proper value.
Proper Connector Torque
• Provides more accurate measurements

• Keeps moisture out of the connectors

• Eliminates radio frequency interference (RFI) from affecting your measurements

The torque required depends on the type of connector. Refer to Table 1.  
Never exceed the recommended torque when attaching cables.

Table 1 Proper Connector Torque

Connector Torque cm-kg Torque N-cm Torque in-lbs Wrench P/N

Type-N 52 508 45 hand tighten

3.5 mm 9.2 90 8 8720-1765

SMA 5.7 56 5 8710-1582
Connector Wear and Damage
Look for metal particles from the connector threads and other signs of wear (such as 
discoloration or roughness). Visible wear can affect measurement accuracy and 
repeatability. Discard or repair any device with a damaged connector. A bad connector 
can ruin a good connector on the first mating. A magnifying glass or jeweler’s loupe is 
useful during inspection.
SMA Connector Precautions
Use caution when mating SMA connectors to any precision 3.5 mm RF connector. SMA 
connectors are not precision devices and are often out of mechanical tolerances, even 
when new. An out-of-tolerance SMA connector can ruin a 3.5 mm connector on the first 
mating. If in doubt, gauge the SMA connector before connecting it. The SMA center 
conductor must never extend beyond the mating plane.
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Cleaning Procedure
70
1 Blow particulate matter from connectors using an environmentally-safe aerosol such 
as Aero-Duster. (This product is recommended by the United States Environmental 
Protection Agency and contains tetrafluoroethane. You can order this aerosol from 
Agilent (see Table 2).)

2 Use alcohol and a lint-free cloth to wipe connector surfaces. Wet a small swab with a 
small quantity of alcohol and clean the connector with the swab. 

3 Allow the alcohol to evaporate off of the connector before making connections.
CAUTION Do not allow excessive alcohol to run into the connector. Excessive alcohol entering 
the connector collects in pockets in the connector’s internal parts. The liquid will 
cause random changes in the connector’s electrical performance. If excessive 
alcohol gets into a connector, lay it aside to allow the alcohol to evaporate. This may 
take up to three days. If you attach that connector to another device it can take 
much longer for trapped alcohol to evaporate.
Table 2 Cleaning Supplies Available from Agilent

Product Part Number

Aero-Duster 8500-6460

Isopropyl alcohol 8500-5344

Lint-Free cloths 9310-0039

Small polyurethane swabs 9301-1243
WARNING Cleaning connectors with alcohol should only be performed with the 
instruments’ mains power cord disconnected, in a well ventilated area. 
Connector cleaning should be accomplished with the minimum amount of 
alcohol. Prior to connector reuse, be sure that all alcohol used has dried, and that 
the area is free of fumes.

WARNING If flammable cleaning materials are used, the material should not be stored, or 
left open in the area of the equipment. Adequate ventilation should be assured to 
prevent the combustion of fumes, or vapors.
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This section introduces you to the various cable and connector types used in the system. 
Read this section before attempting to remove or install an instrument! Each connector 
type may have unique considerations.

Always use care when working with system cables and instruments.
Figure 20 GPIB, 3.5 mm, Type-N, power sensor, and BNC connectors

GPIB Type Connector
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GPIB connectors

These are removed by two captured screws, one on each end of the connector; these 
usually can be turned by hand. Use a flathead screwdriver if necessary.

GPIB connectors often are stacked two or three deep. When you are removing multiple 
GPIB connectors, disconnect each connector one at a time. It is a good practice to 
connect them back together even if you have not yet replaced the instrument; this avoids 
confusion, especially if more than one instrument has been removed.

When putting GPIB connectors back on, you must again detach them from one another 
and put them on one at a time.

Precision 3.5 mm connectors

These are precision connectors. Always use care when connecting or disconnecting this 
type of connector. When reconnecting, make sure you align the male connector properly. 
Carefully join the connectors, being careful not to cross-thread them. 

Loosen precision 3.5 mm connectors on flexible cables by turning the connector nut 
counter-clockwise with a 5/16 inch wrench. Always reconnect using an 8 inch-lb torque 
wrench (Agilent part number 8720-1765). Semirigid cables are metal tubes, 
custom-formed for this system from semirigid coax cable stock.

3.5 mm connectors with a gold hex nut

The semirigid cables that go to the RF outputs of some devices have a gold connector 
nut. These do not turn. Instead, the RF connector on the instrument has a cylindrical 
connector body that turns. To disconnect this type of connector, turn the connector body 
on the instrument clockwise. This action pushes the cable’s connector out of the 
instrument connector. 

To reconnect, align the cable with the connector on the instrument. Turn the connector 
body counterclockwise. You may have to move the cable slightly until alignment is 
correct for the connectors to mate. When the two connectors are properly aligned, 
turning the instrument’s connector body will pull in the semirigid cable’s connector. 
Tighten firmly by hand.

3.5 mm connectors with a silver hex nut

All other semirigid cable connectors use a silver-colored nut that can be turned. To 
remove this type of connector, turn the silver nut counter-clockwise with a 5/16 inch 
wrench.

When reconnecting this type of cable:
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• Carefully insert the male connector center pin into the female connector. (Make sure 
the cable is aligned with the instrument connector properly before joining them.)

• Turn the silver nut clockwise by hand until it is snug, then tighten with an 8 inch-lb 
torque wrench (part number 8720-1765).

Bent Semirigid Cables

Semirigid cables are not intended to be bent outside of the factory. An accidental bend 
that is slight or gradual may be straightened carefully by hand. Semirigid cables that are 
crimped will affect system performance and must be replaced. Do not attempt to 
straighten a crimped semirigid cable.
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To remove an instrument from the system, use one of the following procedures.

Required tools

• #2 Phillips screwdriver

• #2 POZIDRIV screwdriver
Standard instrument
To remove an instrument from a rack

Step Notes

1 Turn off system power, but leave the system 
computer turned on. 

• If you do plan to turn computer power off 
for any reason, have the computer system 
administrator:

• Shut down all running software.
• Shut down the computer.

2 Read “General Procedures and Techniques”, 
then disconnect all cables on the front and on 
the rear panel.

• Most cables are fairly easy to remove and 
reconnect, and have no special 
considerations (besides making sure you 
put the cables back in the right place). 

• Semirigid cables require more care, 
especially when reconnecting them. Make 
sure all semirigid cables, on the front and 
back of an instrument are fully 
disconnected before removing the unit.

3 When all cables are disconnected (including 
the power cord), remove the screws in the 
instrument’s rack “ears” that hold it in the 
rack. 

4 Slide the instrument out. • If you feel any resistance when attempting 
to pull the instrument out, STOP! Look 
inside the cabinet and carefully examine 
all surrounding cables. Make sure all 
cables are fully disconnected.
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To remove a half-width instrument from a system rack 

1 Power off the system. • For details see the system installation 
guide. 

2  Remove the selected instrument’s power cord 
from the power strip in the rack.

3 The instrument is attached to the half-rack width 
instrument beside it; remove that instrument’s 
power cord from the power strip also.

• The instruments are secured together 
by lock links at the front and rear. The 
lock links at the rear attach with screws. 
The lock links at the front hook together. 

4 Remove the power cord and other cables from the 
front and rear of both instruments.

• Note the location of cables for 
re-installation.

5 Remove the four corner screws on the front of the 
rack panel that secures the instruments in place.

• The screws are located near the corners 
of the face of the instrument.

• Use a #2 Phillips screwdriver.

6 Slide both instruments, as a single unit, out from 
the front of the rack and set them on a secure, flat 
surface.
Benchtop Instrument
To remove an instrument from a bench top system 

1 Power off each instrument in the system.

2  Unplug the selected instrument’s power 
cord from the AC power supply.

3 Remove the power cord and other cables 
from the front and rear of the instrument.

• Note the location of cables for re-installation.
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To install or reinstall an instrument in a system, use one of the following procedures.

Required tools

• #2 Phillips screwdriver

• #2 POZIDRIV screwdriver

• system installation guide
Standard rack instrument
To install an instrument

Step Notes

1 Slide the instrument gently into the rack.

2 Insert the screws in the rack ears. • Most cables are fairly easy to remove and 
reconnect and have no special 
considerations (besides making sure you 
put the cables back in the right place). 

• Semirigid cables require more care, 
especially when reconnecting them. Make 
sure all semirigid cables, on the front and 
back of an instrument are fully 
disconnected before removing the unit.

3 To reconnect the semirigid cables, carefully 
align them before you insert the male 
connector. 

• Do not insert the male pin in at an angle or 
you will damage the female connector. RF 
connector center pins are very delicate, 
and if damaged must be replaced. System 
performance may be greatly impaired if 
there is a bad RF connector.

4 Turn on system power and restart the system 
computer if necessary.
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To install the instrument in a rack 

Step Note

1 Make sure the system is powered off.

2 Insert the attached instruments in the same 
slot from which you removed them, sliding 
them along the support rails until they meet 
the rack-mount ears.

• The rack-mount ears stop the instruments at 
the correct depth.

3 Replace the rack panel in front of the 
instruments and secure the four corner 
screws.

• The screws are located near the corners of 
the face of the instrument.

• Use a #2 Phillips screwdriver.

4 Confirm that the instrument is turned off.

5 Connect the appropriate cables to the 
instruments (front and rear), including the 
power cords.

6 Power on the system. . 
Bench top instrument
To install an instrument in a bench top system 

1 Make sure the system is powered off.

2 Connect all cables to the instrument (front 
and rear), including the power cord.

3  Connect the power cord to the AC power 
source.

4 Power on the system.

5 Set the instrument GPIB address, if 
necessary.
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Service, Support, and Safety 
Information

“Safety and Regulatory Information" on page 80”

“Service and Support" on page 86

This chapter provides safety and regulatory information that should be 
reviewed prior to working with the Agilent system. The information 
contained in this chapter applies to all Agilent-supplied instruments in 
the system and the system as a whole.

It also contains information on servicing and obtaining support for an 
Agilent system or instrument, including procedures for removing an 
instrument from a system, returning it to Agilent, and reinstalling it.
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Safety and Regulatory Information

EMC
80
Complies with European EMC Directive 89/336/EEC, amended by 93/68/EEC

• IEC/EN 61326

• CISPR Pub 11 Group 1, Class A

• AS/NZS CISPR 11:2002

• ICES/NMB-001

Complies with Canadian EMC Requirements

This ISM device complies with Canadian ICES-001

Cet appareil ISM est conforme a la norme NMB du Canada.
Safety
Complies with European Low Voltage Directive 73/23/EEC, amended by 93/68/EEC

• IEC/EN 61010-1

• Canada: CSA C22.2 No. 61010-1

• USA: UL 61010-1
Safety Summary
The following general safety precautions must be observed during all phases of 
operation of this instrument or system. Failure to comply with these precautions or with 
specific warnings elsewhere in this manual violates safety standards of design, 
manufacture, and intended use of this instrument or system. Agilent Technologies, Inc. 
assumes no liability for the customer’s failure to comply with these requirements.

General

This product has been designed and tested in accordance with the standards listed on the 
Manufacturer’s Declaration of Conformity, and has been supplied in a safe condition. 
The documentation contains information and warnings that must be followed by the user 
to ensure safe operation and to maintain the product in a safe condition. Contact your 
Agilent sales representative to obtain a copy of the Declaration of Conformity. 
Alternately, contact Agilent via: www.Agilent.com.

Compliance with German Noise Requirements

This is to declare that this instrument is in conformance with the German Regulation on 
Noise Declaration for Machines (Laermangabe nach der Maschinenlaermrerordnung 
-3.GSGV Deutschland.
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Acoustic Noise Emission/Geraeuschemission

LpA <70 dB
Operator position
Normal position
per ISO 7779

LpA <70 dB
am Arbeitsplatz
normaler Betrieb
nach DIN 45635 t.19
Agilent N8221A IF Dig
All light-emitting diodes (LEDs) used in this product are Class 1 LEDs per IEC 60825-1.
Equipment Installation
Install the instrument or system so that the detachable power cord is readily identifiable 
and is easily reached by the operator. The detachable power cord is the disconnecting 
device. It disconnects the mains circuits from the mains supply before other parts of the 
instrument or system. The instrument front panel switch is only a standby switch and is 
not a LINE switch. Alternatively, an externally installed switch or circuit breaker (which 
is readily identifiable and is easily reached by the operator) may be used as a 
disconnecting device.
WARNING This is a Safety Class 1 Product (provided with a protective earthing ground 
incorporated in the power cord). The mains plug shall be inserted only in a socket 
outlet provided with a protective earth contact. Any interruption of the protective 
conductor inside or outside of the products is likely to make the product 
dangerous. Intentional interruption is prohibited (IEC 348 clauses 17.3.3 c and 
17.3.4).

WARNING DO NOT OPERATE IN AN EXPLOSIVE ATMOSPHERE. 
Do not operate the instrument or system in the presence of flammable gases or 
flames.

WARNING Danger of explosion if battery is incorrectly replaced. Replace only with the 
same or equivalent type recommended. Discard used batteries according to 
manufacturer’s instructions.

WARNING DO NOT REMOVE AN INSTRUMENT COVER.

Operating personnel must not remove instrument covers. Component 
replacement and internal adjustments must be made only by qualified service 
personnel.

Instruments that appear damaged or defective should be made inoperative and 
secured against unintended operation until they can be repaired by qualified 
service personnel.
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Environmental Conditions

Before Applying Power

Magnetic Susceptibility

WARNING If this product is not used as specified, the protection provided by the equipment 
could be impaired. This product must be used only in a normal condition (in which 
all means for protection are intact).

CAUTION Unless otherwise noted in the specifications, this instrument or system is intended 
for indoor use in an installation category II, pollution degree 2 environment per IEC 
61010 second edition and 664 respectively. This instrument or system is designed 
to operate at altitudes up to 4600 meters, and at temperatures between 0°C and 
55 °C.

CAUTION Ventilation Requirements: When installing the product in a cabinet, the convection 
into and out of the product must not be restricted. The ambient temperature 
(outside the cabinet) must be less than the maximum operating temperature of the 
product by 4 °C for every 100 watts, then forced convection must be used.

CAUTION Verify that the product is set to match the available line voltage, the correct-rating 
service breaker is installed, the correct fuse is installed, and all safety precautions 
are taken. Note the instrument external markings described in Table 3, “Safety symbols 
and instrument markings,” on page 84.

Position the instrument so that it is not difficult to operate the disconnecting device.

This instrument has autoranging line voltage input, be sure the supply voltage is 
within the specified range.

WARNING The mains wiring and connectors shall be compatible with the connector used in 
the premise electrical system. Failure to ensure adequate earth grounding by not 
using the correct components may cause product damage and serious injury.

CAUTION Degradation of some product specifications can occur in the presence of ambient 
power frequency magnetic fields of 30 A/m or greater. The product self-recovers 
and operates as specified when removed or shielded from the ambient magnetic 
fields.
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Vibration

Ground the Instrument or System

Fuses and Circuit Breakers

CAUTION Degradation of some product specifications can occur if this instrument is operated 
while subjected to continuous vibrations of less than or equal to 0.21 grms in the  
5 Hz to 500 Hz frequency range.

WARNING To minimize shock hazard, the instrument chassis and cover must be connected 
to an electrical protective earth ground. The instrument and/or system must be 
connected to the AC power mains through a grounded power cable, with the 
ground wire firmly connected to an electrical ground (safety ground) at the 
power outlet. Any interruption of the protective (grounding) conductor or 
disconnection of the protective earth terminal will cause a potential shock 
hazard that could result in personal injury.

WARNING This is a Safety Class 1 Product (provided with a protective earthing ground 
incorporated in the power cord). The mains plug shall be inserted only in a socket 
outlet provided with a protective earth contact. Any interruption of the protective 
conductor inside or outside of the products is likely to make the product 
dangerous. Intentional interruption is prohibited (IEC 348 clauses 17.3.3 c and 
17.3.4).

CAUTION Always use the three-prong AC power cord supplied with this product. Failure to 
ensure adequate earth grounding by not using this cord may cause product damage.

CAUTION The detachable power cord is the disconnecting device. It disconnects the mains 
circuit from the mains supply before other parts of the instrument or system. The 
instrument front panel switch is only a standby switch and is not a line switch.
Agilent N8221A IF Dig
Refer to individual instrument manuals for detailed information on operator accessible 
fuses.
WARNING Use only fuses with the required rated current, voltage, and specified type 
(normal blow, time delay). Do not use repaired fuses or short-circuited fuse 
holders. To do so could cause a shock or fire hazard.

WARNING For continued protection against fire hazard, replace fuses and circuit breakers 
only with the same type and ratings. The use of other fuses or circuit breakers or 
materials is prohibited (IEC 348 clause 17.3.5.d).
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WARNING The premise wiring should have a system-dedicated circuit breaker in the mains 
wiring for installation of the system.
84
Agilent system cabinet power strips are equipped with a thermal circuit breaker for each 
power phase. If one phase shorts or overloads, one or both of the circuit breakers in the 
power strip trip. Unplug the power strip before trying to locate and correct the electrical 
problem, then reset both circuit breakers on the power strip to restore power to the 
cabinet.
Maintenance

Safety symbols and Instrument Markings

WARNING To prevent electrical shock, disconnect the instrument and/or system from 
mains before cleaning. Use a dry cloth or one slightly dampened with water to 
clean the external case parts. Do not attempt to clean internally.
Symbols and markings in manuals and on instruments alert you to potential risks, 
provide information about conditions, and comply with international regulations. Table 3 
defines the symbols and markings you may find in a manual or on an instrument.

Table 3 Safety symbols and instrument markings 

Safety symbols Definition

Warning: risk of electric shock.

Warning: hot surface.

Caution: refer to instrument documentation.

The CE mark is a registered trademark of the European 
Community. 

The CSA mark is a registered trademark of the 
CSA-International. This instrument is in compliance with CSA 
1010 Edition2.

The C-tick mark is a registered trademark of the Spectrum 
Management Agency of Australia. This signifies compliance 
with the Australian EMC Framework regulations under the 
terms of the Radio Communications Act of 1992.

N10149
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This symbol indicates separate collection for electrical and 
electronic equipment, mandated under EU law as of August 13, 
2005. all electric and electronic equipment are required to be 
separated from normal waste for disposal (Reference WEEE 
Directive, 200/96/EC).

ISM1-A This text indicates that the instrument is an Industrial Scientific 
and Medical Group 1 Class A product (CISPER 11, Clause 4).

ICES/NMB-001 This text indicates product compliance with the Canadian 
Interference-Causing Equipment Standard (ICES-001).

Laser radiation symbol: marked on products that have a laser 
output.

Alternating current.

Both direct and alternating current.

Three-phase alternating current.

Earth (ground) terminal.

Protective earth (ground) terminal.

Frame or chassis terminal.

Terminal is at earth potential. Used for measurement and 
control circuits designed to be operated with one terminal at 
earth potential.

Terminal for neutral conductor on permanently installed 
equipment.

Terminal for line conductor on permanently installed 
equipment.

Standby (supply); units with this symbol are not completely 
disconnected from AC mains when this switch is in the standby 
position. To completely disconnect the unit from AC mains, 
either disconnect the power cord, or have a qualified/licensed 
electrician install an external switch.

OFF (supply); a switch with this symbol opens the instrument’s 
power supply circuit, disconnecting it with the mains supply.

ON (supply); a switch with this symbol closes the instrument’s 
power supply circuit, connecting it with the mains supply.

Table 3 Safety symbols and instrument markings (continued)

Safety symbols Definition
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Service and Support
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Any adjustment, maintenance, or repair of this product must be performed by qualified 
personnel. Contact your Agilent Technologies Service Center for assistance. 
Agilent on the Web

WARNING There are no user serviceable parts inside the system. Any servicing instructions 
are for use by qualified personnel only. To avoid electrical shock, do not perform 
any servicing unless you are qualified to do so.

WARNING The opening of covers or removal of parts is likely to expose dangerous voltages. 
Disconnect the product from all voltage sources while it is being opened.

CAUTION Any operator-replaceable parts or supplies are required to be examined or supplied 
by Agilent Technologies.
You can find information about technical and professional services, product support, and 
equipment repair and service on the Web:

http://www.agilent.com 

Click on the Test & Measurement link then click on Select a Country. Click on the 
Contact Us link for contact information.
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Return Procedure
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In any correspondence or telephone conversations with Agilent Technologies, please 
refer to the instrument by its model number (N8201A, for example) and serial number. 
With this information, the customer engineer can determine whether your instrument is 
still within its warranty period and provide accurate shipping information.
Shipping the Instrument
Use the following procedure to package and ship your instrument for service. For 
instructions on removing an instrument from the system and re-installing it, refer to the 
system user’s guide.

To package the instrument for shipping 

Step Notes

1 Place the instrument in its original packaging 
materials.

• If the original packaging materials are 
not available, use a professional 
packaging service. Contact your Agilent 
Service Center for more information.

2 Surround the instrument with at least 3 to 4 
inches of its original packing material or 
bubble-pack to prevent the instrument from 
moving in its shipping container.

3 After wrapping it with packing material, place the 
instrument in its original shipping container or a 
strong shipping container that is made of 
double-walled corrugated cardboard with 159 kg 
(350 lb) bursting strength.

• The shipping container must be large 
and strong enough to accommodate 
your instrument and allow at least 3 to 4 
inches on all sides for packing material.

4 Seal the shipping container securely with strong 
nylon adhesive tape.

5 Mark the shipping container “FRAGILE, HANDLE 
WITH CARE” to help ensure careful handling.

6 Use the address obtained from your Agilent 
customer engineer.

7 Retain copies of all shipping papers.
CAUTION Damage can result if the original packaging materials are not used. Packaging 
materials should be anti-static and cushion the upconverter on all sides. NEVER 
USE STYRENE PELLETS IN ANY SHAPE AS PACKAGING MATERIALS. They do not 
adequately cushion the instrument or prevent it from moving in the shipping 
container. Styrene pellets can also cause equipment damage by generating static 
electricity or by lodging in fan motors.
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Glossary

Auto-IP Auto-IP is a method used by a device to self select an IP address. When a 
device is using Auto-IP, it randomly selects an address of the form 169.254.x.x. If 
another device is already using that address, it selects another random address, and 
continues to select new addresses until it finds one that is not being used by any other 
instrument.

Cross-Over Cable A cross-over cable can be used to connect two devices directly to 
each other, without a network switch or any other hardware in-between. It is common to 
use static IP addresses when devices are connected using a cross-over cable, because 
there is no DNS, and there are no other devices on the connection that could cause an IP 
address conflict.

Default Gateway The default gateway is used by a device to communicate with 
devices that have IP addresses that are on different subnets. This would usually be the IP 
address of the router that connects the device’s subnet to the rest of the network.

DHCP [Dynamic Host Configuration Protocol] In order to avoid IP address conflicts, 
and to simplify the process of connecting devices to a network, larger networks will 
sometimes use DHCP to assign IP addresses to devices.

When a device is configured to use DHCP, it attempts to communicate with the DHCP 
server when it is powered on. If it is able to communicate with the server, it asks the 
server for the correct network settings (including IP Address, Subnet Mask, Gateway, 
and so on) to communicate on the network. If the device is unable to communicate with 
the DHCP server, it will either go into a failure mode, or (if configured to do so) it will 
attempt to assign itself an IP address. (See Auto-IP)

Because the IP address assigned to an instrument can be different every time it is 
powered on, you cannot remember the IP address and expect to always be able to use 
that address to communicate with the instrument. However, networks using DHCP will 
often also use DNS, which can allow you to communicate with a device using a 
hostname that will stay the same, even if the device’s IP address has changed.

DHCP Server The DHCP server responds to devices’ requests for network settings. It 
is responsible for ensuring that no two devices attempt to use the same IP address.
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DNS [Domain Name Server] A domain name server allows someone to communicate 
with a device using the device’s hostname. When a device joins a network, it tells the 
domain name server its hostname and its IP address. When a hostname is used, the 
domain name server is asked which IP address the name corresponds to, and that address 
is then used to communicate with the instrument. 

If the IP address of the device changes, it can request that its entry in the domain name 
server be updated. Any following requests that use the same hostname as before, will be 
sent to the new address.

Hostname A hostname is a unique name that can be used to communicate with a 
device on a network. Hostnames are commonly used in situations where devices have 
their addresses assigned to them using DHCP.

Hostnames can only be used if there is some way that the network can keep track of 
which hostname corresponds to an instrument. This is usually done using DNS. 

Networks without DNS have no way to associate a hostname with a device. This is often 
true of small private LAN networks (for example, a network consisting of two devices 
connected using a cross-over cable, or through a simple router). In these cases, it is 
probably easiest to use static IP addresses.

IP Address [Internet Protocol Address] An IP address is a unique number assigned to 
a device which is used to send or receive data to and from other devices.

The most common IP addresses are IP Version 4. These addresses are usually written as 
four numbers (from 1 to 255) separated by periods. For example, 192.168.1.1 and 
169.254.12.34 and 141.121.84.241 are all IP addresses.

A device’s IP address can be assigned to it manually (See Static IP Address), assigned 
to it by another computer (See DHCP) or can be self-determined (See Auto-IP).

IP Address Conflict An IP address conflict occurs when two devices attempt to join 
the same network with the same IP address. When this happens, it may become 
impossible to communicate with either instrument over the LAN. Using dynamically 
assigned addresses can help avoid this problem. (See DHCP or Auto-IP.)

LAN [Local Area Network] A LAN is a network of devices connected to each other 
using LAN cables and network switches.

Network Switch A network switch is used to connect several devices together to form 
a LAN. It has several LAN ports that LAN cables can be connected to.

If it is necessary to create a network with more devices than can connect to a single 
network switch, one (or more) switches can be attached to the first switch.

Private LAN  A private LAN network is defined as a local area network in which 
LAN-enabled instruments and Windows PCs are not connected to a site LAN 
(workgroup LAN, Intranet, or enterprise LAN). When using a private LAN, the designer 
of the LAN is responsible for defining all private LAN parameters.
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Private Network All of the devices on a private network use IP addresses that have 

been reserved for private use. The most common private network IP addresses are of the 

form 192.168.x.x and 169.254.x.x. Devices which have been assigned a private 

network IP address cannot generally communicate with other devices outside of their 
private network. Many devices can use the same IP address (for example, 
192.168.1.1) as long as they each belong to different private networks.

Router A router can be used to transfer messages between two (or more) networks. 
Routers are often used to connect a private network to a larger network (for example, a 
company network, or the Internet). The router can also be used to isolate a local network 
from a larger coporate or public network.

Site LAN  A site LAN is a local area network in which LAN-enabled instruments and 
Windows PCs are connected to a site LAN (workgroup LAN, Intranet, or enterprise 
LAN) through (optional) routers, hubs, and/or switches.

Static IP Address A device uses a static IP address when it always attempts to use the 
same IP address every time that it is turned on. Using a static IP address can be useful if 
you always want to communicate with an instrument using the same address every time 
it is turned on. However, using a static IP address can lead to IP address conflicts if two 
instruments are given the same static IP address.

Subnet (Subnetwork) A subnet is a group of devices which is a subset of a larger 
group of devices. Breaking a large network down into many smaller subnets can make 
the network easier to manage, and can decrease the amount of traffic that gets sent 
between devices.

One thing a device on a network can do is send a message to all of the other devices on 
its subnet. If a network consists of only a single subnet, that message would have to be 
sent to every device on the network. However, if the network has been broken down into 
subnets, the message would only be sent to other devices on the same subnet as the 
device sending the message.

Subnet Mask A subnet mask is used to specify how a network is broken down into 
subnets. Subnet masks look like IP addresses; they are of the form x.x.x.x. Common 
subnet masks include 255.0.0.0, 255.255.0.0 (use this for private networks), 
and 255.255.255.0.

When written in binary, subnet masks usually become several 1s followed by several 0s.

For example: 

255.255.0.0 

would become 

11111111.11111111.00000000.00000000.
itizer Synthetic Instrument Module, 30 MS/s 91
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The subnet mask can be used with a device’s IP address to determine the address of the 
subnet that the device is on. To do this, you perform a logical AND of the subnet mask 
and the IP address. (A logical AND combines two binary numbers into a single number. 
The new number contains 1s in positions where both numbers had 1s, and 0s 
everywhere else.)

For example, if a device has an IP address of 192.168.12.34 and the subnet mask 
255.255.255.0 then:
192.168.12.34 = 11000000. 10101000. 00001100. 00100010

255.255.255.0 = 11111111. 11111111. 11111111. 00000000

Subnet Address = 11000000. 10101000. 00001100. 00000000

192 168 12 0
The device is on the subnet with the 192.168.12.0 address.

A device with the IP address 192.168.12.100 is on the same subnet as the device 
with the IP address 192.168.12.34 (the 192.168.12.0 subnet), but a device with 
an IP address of 192.168.100.34 is on a different subnet (the 192.168.100.0 
subnet).
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